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INTRODUCTION 

This manual contains technical information about the creation of Pitt Meadows Geodatabase. 

The developed Geodatabase is the first version and will require future implementations or 

revisions. This Geodatabase includes only data that can be linked to the cadastre feature layer.  

Information on the software is provided to give the administrator some background knowledge of 

how the Geodatabase was developed and tested. 

 

SOFTWARE USED 

The following are the software used for creating this Geodatabase v1.0. 

• Operating System: Windows 2000 

• ESRI ArcView GIS 3.1  

• ESRI ARC/INFO Workstation 8.2 

• ESRI ARCGIS 8.2 

• MICROSOFT VISIO 2002 
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DATA CREATION, JUSTIFICATION AND STANDARDIZATION 

The following are the steps that are used in formatting the data required for this geodatabase 

v1.0. 

 

Data Projection 

The projection of all data is UTM Zone 10 NAD 83 coordinate system.  Data that do not conform 

to this projection are reprojected or moved manually using the EDIT option in ArcMap.  For this 

geodatabase, only the water services had to be manually moved in ArcMap because of its 

unknown projected distortion. 

 

Cadastre Annotations (Lot & Plan numbers) Creation using AML 

Two AML Scripts are used in creating the cadastre annotations of lot and plan numbers: 

cad_annolot.aml and cad_annoplan.aml. These AML scripts were modified versions of 

annotation AML created by Darrin Grund at Land Reserve Commission.   The scripts can only 

run on ARC/INFO workstation ARC Prompt platform.  The scripts cannot run on ArcGIS Toolbox 

because Toolbox does not support commands from ARC/INFO ARCPLOT which is the backbone 

of this AML. 

 

The procedure assumes that the cadastre coverage, cad_annolot.aml and cad_annoplan.aml 

are the only files in the working directory (workspace).  By running the cad_annolot.aml, a new 

coverage named cad_anno with lot annotation subclass is created.  This aml will then add plan 

annotation subclass to the cad_anno coverage by calling cad_annoplan.aml.  To see the actual 

commands used in the AML, see APPENDIX 1 and 2 for ARC/INFO.  To start the AMLs, go to 

the workspace where the AML is stored and type the following in ARC prompt: 

 

Arc: &run cad_annolot.aml 

 

The resulted cad_anno coverage will contain lot and plan annotations in different text sizes 

based on their corresponding parcel area size.  This cad_anno coverage should be generated 

whenever there is an update on the cadastre data layer. 

 

Cadastre UNIQUE ID Creation 

The UNIQUE ID column for the cadastre data of this geodatabase v1.0 is created by joining the 

JUROL and PID attribute columns.  This is done because if new cadastre parcels are added, 

the unique ID for each parcel can be created easily by joining the two columns.  However, since 

not all parcels have PID or JUROL numbers in the current cadastre layer, the resulted 

performance is not as good, so it requires future revisions.  This UNIQUE ID is finally not used 

for linkage in the geodatabase v1.0. 
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Adjusting cadastral boundaries of other data layers (i.e. crops) 

Feature Data Layers that have shifted/distorted cadastral boundaries (i.e. crops) can be adjusted 

correctly using the new cadastre data boundaries following these steps: 

 

1) Create an attribute column in the cadastre coverage that has unique numbers for each 

record.  Another option is to use the ARC/INFO # or ARC/INFO ID column that should 

have unique value for each record.  These two columns are generated automatically by 

ARC/INFO when the coverage is created. 

 

2) Overlay the cadastre coverage (having unique numbers) with the data coverage that you 

wanted to adjust using the UNION ARC/INFO command.  The resulted union coverage will 

have both attribute columns from cadastre and the original adjusting data layer.  To do this, 

type the following in ARC/INFO ARC Prompt: 

 

 Arc: UNION cadastre crops union_cov 0.01 JOIN 

 

 The ARC/INFO usage for UNION command is: 

 

 Arc: UNION <in_cover> <union_cover> <out_cover> {fuzzy_tolerance} {JOIN | 

NOJOIN} 

 

 NOTE: ARC/INFO only allows coverage names with 13 characters, so give an <out_cover> 

name less than this character width.  The <> brackets are required variables that you must 

define while variables in {} brackets are not required.  If the {} variables are not typed, the 

default ARC/INFO values are used.  In the given example, 0.01 tolerance (which equals 

1cm) is used. 

 

3) Remove the original boundaries of the adjusting data layer using the DISSOVE command.  

For example, in ARC Prompt: 

 

 Arc: DISSOLVE union_crops diss_crops cadastre-ID POLY 

  

 The ARC/INFO usage for DISSOLVE command is: 

 

 Arc: DISSOLVE <in_cover> <out_cover> <dissolve_item | #ALL> {POLY | LINE | NET | 

REGION.subclass} 
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 NOTE: dissolve_item is the column name of cadastre that you defined in step 1 that is used 

to perform this DISSOLVE function.  The POLY | LINE | NET | REGION.subclass allows 

you to define the feature class for dissolving.  In the above case, the feature class is POLY 

(Polygon). 

 

4) Add the attribute columns of original adjusting data layer back to the new dissolved 

coverage through joining.  This is required because the DISSOLVE COMMAND only adds 

the cadastre's dissolve_item attribute column to the resulted dissolved coverage.  Since 

the original adjusting data layer don't have this cadastre's dissolve_item column, will need 

to use the union coverage to perform the joining.  The join can be done using the 

JOINITEM command in ARC PROMPT: 

 

 Arc: JOINITEM diss_crops union_crops diss_crops cadastre-ID 

 

 The ARC/INFO usage for JOINITEM command is: 

 

 Arc: JOINITEM <in_info_file> <join_info_file> <out_info_file> <relate_item> {start_item} 

{LINEAR | ORDERED | LINK} 

 

 NOTE: relate_item is the item that you can join between the info files.   

 

5) Manually add missing boundaries in the original adjusting data back to the new dissolve 

coverage.   This is not required if the original data layer contains only cadastre boundaries.  

For the crops layer in this geodatabase, there are some sub-divided parcel boundaries in 

the North that require manual addition.  The manual addition is done using ARCEDIT. 

 

6) At last, rename the dissolve coverage properly using the RENAME command.  For 

example: 

 

 Arc: RENAME diss_crops crops 

 

 The ARC/INFO usage for RENAME command is: 

 

 Arc: RENAME <old_geo_dataset> <new_geo_dataset> 

 

Formatting JUROL/PCLLINKSID numbers 

Many roll number attribute columns in various data layers (attribute and feature) have 

inconsistent attribute type or format when compared to the cadastre's JUROL or PCLLINKSID 
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(both are Pitt Meadows Jurisdiction roll numbers) attribute column.  Some roll numbers use 

dashes, some have missing zeros or some are in integer format (but both JUROL and 

PCLLINKSID in cadastre are in string format).  Furthermore, some data contain roll numbers for 

Maple Ridge.  Therefore, the formatting process requires careful matching, so it cannot be 

automated.  The following are two different procedures in formatting the roll numbers: 

 

Formatting the roll numbers to match cadastre’s JUROL format 

1) Create a new attribute column called JUROL as string type. 

2) Add the existing roll number values to the new JUROL column.   

3) Make sure the roll numbers in the new JUROL column has “12319” as the first 5 digits 

where “12” represents Lower Mainland area and “319” represents Pitt Meadows 

Municipality.  If the roll numbers don’t have these numbers, add them.   

4) Make sure the resulted roll number values have a character width of 12.  If the width is < 

12, this is likely because of missing zero after “12319”.  For example, JUROL number 

“123190008000”.   

 

Formatting the roll numbers to match cadastre’s PCLLINKSID format 

1) Create a new attribute column called PCLLINKSID as string type. 

2) Add the existing roll number values to the new PCLLINKSID column. 

3) Make sure the roll numbers in the new PCLLINKSID column have a decimal place before 

the last 3 digits of the roll number.  If not, then add the decimal place. 

4) Make sure the resulted roll number values have a character width of 8.  If the width is < 8, 

this is like because missing zero as the first digit.  For example, PCLLINKSID number 

“0366.001”. 

 

NOTE: For both formatting procedures, if the resulted roll numbers are in odd format, this is 

probably because they are Maple Ridge or other area's jurisdiction roll numbers. 

 

Metadata Creation in ArcCatalog 

Metadata for each data layer is created using the FGDC metadata editor in ArcCatalog.  FGDC 

is the Federal Geographic Data Committee approved Standard for Digital Geospatial Metadata 

which is used by the Integrated Cadastral Initiative Society (ICIS).  XML tags are used by 

ArcCatalog to store the keyed-in metadata information.  The following are the general steps 

involved in editing/adding new metadata: 

1) In ArcCatalog, click Tools and click Options. 

2) Click the Metadata tab in the Options dialog box. 

3) Click the Metadata Editor drop down arrow and click the FGDC editor if not currently 

selected.  
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4) Click OK.  

5) Click the data layer (attribute or feature) whose metadata you want to add/edit in the 

Catalog tree on the left. 

6) Click the Metadata tab.  

7) Click the Edit Metadata button  on the Metadata toolbar.  
8) Enter required metadata information using the editing dialog box.  The following are the 

general metadata information keyed in for this geodatabase v1.0. 

 Data Contact Information 

 Data Description (Abstract, Purpose and keywords) 

 Data Disclaimer (Use Constraints) 

 Data Distribution Information 

 Data Revision 

 Data Source  

The above information are entered under Identification, Data Quality and Distribution tabs 

of the editing dialog box 

9) Close the metadata editor when finished entering. 

NOTE: Since most information is same among data layers such as Data Contact Information and 

Disclaimer, you can increase efficiency by importing an existed XML metadata.  To accomplish 

this, click Import Metadata button  before doing steps 7 to 9.  In the popped up Import 
Metadata dialog box, navigate to the existing XML metadata and select “FGDC CSDGM (XML)” 

and click OK. 

 

 

 

 

 

 

 

 



USER’S DOCUMENTATION  P.8 
Pitt Meadows Geodatabase V1.0 Basic Technical Manual                                                    
 
UML MODELLING 

The following are the steps in creating the UML Model for geodatabase v1.0 using Microsoft Visio 

2002. 

 

STEP 1: Preparing the ESRI UML Model Template 

Setting up the ESRI UML Model Template & Readying it for the Data Model   

1) Open the ESRI ArcInfo UML Model (Visio 2002) template UML Model (Visio 2002) .vst in 

Microsoft Visio Professional 2002 to provide the ESRI framework for the data model 

2) Save the template under the title PittMeadows 

3) Because the data model is to be altered, change the name ArcInfo UML Model in the Model 

Explorer menu at the bottom left of the screen to PittMeadows by right-clicking it and 

selecting Rename 

 

4) Insert a new package (defn: a container for elements, views (diagrams), and other packages) 

into which to begin the data model by navigating through the Model Explorer menu to Pitt 

Meadows > Workspace, right clicking on Workspace and going to New > Package 

5) Name the new package PittMeadows Overview because it is to hold all of the classes 

contained in the Pitt Meadows data model.   

6) Right click PittMeadows Overview and going to New > Static Structure Diagram to create a 

page for mapping out the general framework of the data model.  Relationships between 

data classes will be discussed later as they were described on separate Static Structure 

Diagrams (viewed as pages) called Pitt Meadows Use Cases  
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STEP 2: Establishing Feature and Object Classes 

Adding Classes to the Data Model 

1) Stencils, when not present in the Shapes menu at the upper right hand side of the screen, 

can be added to the right hand side of the screen by going to File > Stencils and choosing 

the stencil class relevant to the data model 

2) The stencils used for this data model can be found in File > Stencils > Software > UML Static 

Structure  

3) Using the ESRI structure, create an ESRI Object Class and an ESRI Feature Class, both by 

navigating through ArcInfo UML System > Pitt Meadows > Logical View > ESRI Classes > 

Feature or Object in the Model Explorer menu and dragging the Feature and Object classes 

onto the PittMeadows Overview Static Structure Diagram 

4) Generalize the Feature Class to the Object Class by dragging the generalization arrow stencil 

from the UML Static Structure Stencil menu and position the arrow ends on the nodes for each 

class with the arrow end towards the top of the hierarchy (the Object Class) 

5) Attribute tables are created and generalized to the Object class while shape files are created 

and generalized to the Feature class.  This is done by clicking and dragging the Class 

Stencil from the UML Static Structure Stencil menu 

 

Setting Attributes and Tagged Values for Object Classes 

1) Add attributes to the classes by double clicking the class on the PittMeadows Classes page 

and selecting Attributes in the left menu 
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2) To add an attribute click the New button and type the name of the attribute into the first empty 

field 

a. Select the attribute data type from the Type drop down menu.  The attribute data 

type must be an esriFieldType  

b. To set the attribute , click the Properties button when the attribute is active  

c. Select Tagged Values in the left menu click the New button  

d. Enter the name of the tagged value into the upper box and its value into the lower 

box 

 

 

i. Add Tagged Values: 

1. AllowNulls: True if attribute fields are allowed to be left empty, 

otherwise False.  All are entered as True in the Pitt Meadows Data 

Model 

2. If data type is esriFieldTypeString or esriFieldTypeDate type Length: 

this is the width of the field 

3. If data type is esriFieldTypeInteger or SmallInteger type Precision: 

this is the width of the field.  SmallInteger must have a width less 

than or equal to 9 

4. If the data type is esriFieldTypeDouble type Precision: this is the 

width of the field, then add another tagged value called Scale: this is 

the number of decimal places included in the width 
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Setting Attributes and Tagged Values for Feature Classes 

1) Follow the steps in Setting Attributes and Tagged Values for Object Classes for Feature 

Classes along with the following: 

2) Double click the Feature Class and select Tagged Values in the left hand menu 

3) Click the New button to allow a new Tagged Value to be added 

a. Add Tagged Values: 

i. GeometryType: esriGeometryPoint, esriGeometryPolyline, or 

esriGeometryPolygon 

ii. HasM: True if the Feature class has a measured value associated with it, 

such as volume otherwise False.  All are entered False in the Pitt 

Meadows Data Model. 

iii. HasZ: True if the Feature class has a z-value (elevation) associated with 

it, otherwise False.  All are entered False in the Pitt Meadows Data 

Model. 

 

Setting up Static Structure Diagrams for the Classes (used to hold relationships) 

1. Add another package to the Workspace and name it PittMeadows Use Cases 

2. For each class added into PittMeadows:  

a. Add a package to PittMeadows Use Cases and name it the Class name (ex. 

Septic) 

b. Add a Static Structure Diagram into the Package and also name it the Class 

name (ex. Septic) 

 

STEP 3: Establishing Relationship Classes 

1) Open the Static Structure Diagram for each class 

2) ***Relationships are not set up in the Cadastral Static Structure Diagram because 

relationships involving Cadastral are defined on each of the other class’s Static Structure 

Diagram 

3) From the PittMeadows Overview menu drag the class to which the relationship is to become 

attached over to the Static Structure Diagram.  This puts the class and all of its attributes 

onto the Static Structure Diagram (ex. Septic).   

4) In the same fashion, add the classes to which the Cadastral layer is to be related.  This only 

includes Cadastral in the Pitt Meadows Data Model 

5) From the UML Static Structure Stencil menu in the Shapes menu drag the Binary Association 

Line to the Static Structure Diagram and attach its ends to a node on either class 

6) Double click the Binary Association Line   
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a. Type in the name of the relationship.  For example, SepticTo was used to illustrate 

that by concatenating the other class in the Static Structure Diagram (Cadastral) the 

relationship goes from SepticToCadastral.   

b. In the Association Ends table 

i. Under End Name type in the relationship name, a colon, and the name of 

the first class (SepticTo:Septic) 

ii. Under Multiplicity select the multiplicity of the relationship from the 

drop-down menu (* (many) for all of the Classes except Cadastral, which is 

1)  

iii. For the next row, the relationship name was typed along with a colon and 

Cadastral (SepticTo:Cadastral) and given Multiplicity of 1 

c. Click Tagged Values in the right menu 

i. Add new Tagged Values: 

1. IsAttributed: True if there is a Relationship Class populated with 

attributes for many-to-many relationships, but False for all of the 

relationships in the PittMeadows data model 

2. OriginClass: the name of the class to be attached to Cadastral (ex. 

Septic) 

3. Notification: esriRelNotificationBackward, 

esriRelNotificationForward, esriRelNotificationBoth, or 

esriRelNotificationNone, but use esriRelNotificationForward for all 

of the relationships in the PittMeadows data model since the 

relationships are aimed from the origin class to Cadastral 

4. OriginPrimaryKey: the name of the attribute column to be linked as 

it exists in the origin class 

5. OriginForeignKey: the name of the attribute column to be linked as it 

exists in Cadastral 

 

STEP 4: Exporting the UML Model to XMI (XML Metadata Interchange) 

1) In Microsoft Visio, click Tools > Macros > Visio Extras > ESRI XMI Export  

2) Give the data model a file name (ex. PittMeadows) and Save 

3) Click OK when the Export Succeeded! box appears 

 

STEP 5: Semantics Checker 

1) In Microsoft Visio, click Tools > Macros > ESRI > Semantics_Checker  

2) Enter the name of the XML document created in the last step 

3) A list of errors in the data model is created 

4) A clear Semantics Check must be passed before the data can be loaded into the data model   
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GEODATABASE CREATION 

The following are the steps in creating the geodatabase v1.0 using ArcGIS ArcCatalog and 

ArcMap. 

 

STEP 1: Installing the CASE Tools XMI Patch 

In ArcGIS 8.2 version, the CASE Tools in ArcCatalog do not support XMI (XML Metadata 

Interchange) files. XMI is an Object Management Group (OMG) standard that specifies how to 

store an UML model in an XML file. With the CASE Tools XMI Update, ArcGIS can read models in 

XMI files as well as models stored in the Microsoft Repository.  This patch can be downloaded 

from ESRI ONLINE SUPPORT CENTER at  

http://arconline.esri.com/arconline/downloads/ao_/case_tools_xmi_update.cfm?id=185&pid=1  

The steps involved in installing this patch are described detailing on the same webpage. 

 

STEP 2: Adding the CASE Tools Wizard to ArcCatalog Toolbar 

1) In ArcCatalog, click Tools and click Customize. 

2) Click the commands tab in the Customize dialog box. 

 

3) Click Case Tools. 

4) Drag the Schema Wizard command from the Commands list and drop it such that the 

Case Tools button  appears on the Standard toolbar. 

5) Click Close on the Customize dialog box. 

 

http://arconline.esri.com/arconline/downloads/ao_/case_tools_xmi_update.cfm?id=185&pid=1
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STEP 3: Creating Empty Geodatabase 

1) In the ArcCatalog tree on the left, right click on the location where you want to create the 

new personal geodatabase. 

2) Click to New > Personal geodatabase as shown below: 

 
3) Type a new name for this personal geodatabase (i.e. pittmeadows) 

4) Press Enter. 

 

STEP 4: Load Attribute Tables to Geodatabase 

The attribute tables are loaded before creating geodatabase schema because after the schema 

is created, ArcGIS does not have automatic functions for importing the attribute values.  You 

can only add the attribute values manually or by writing ArcObjects scripts. 

1) In the ArcCatalog tree, select the created personal geodatabase and right click. 

2) Click Import > Table to Geodatabase. 
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3) In the Table to Geodatabase dialog box, click the batch button  button.   

4) Click the directory button  and select the attribute tables (dbf, info or other formats) 

that you want to add.  You can select multiple attribute tables in the same directory by 

selecting while holding down the SHIFT keyboard button. 

5) If you need to add other attribute tables in other directories, click the add row  button 

and then repeat step 4. 

6) When finishing adding all attribute tables, rename each “Output Geodatabase table” to the 

name that you set for this attribute table in the UML Model as shown below: 

 

 
7) Click OK when finished. 
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STEP 5: Create Geodatabase Schema using CASE Tools and XMI file 

1) In the ArcCatalog tree, click the personal geodatabase. 

2) Click the Schema Wizard button  to start the Case Schema Creation wizard. 

3) A brief introduction to the wizard appears.  Click Next. 

 
 

4) Click Model stored in XMI file in the Schema Wizard.  Then Click Browse to navigate to 

the XMI file you created. 

 

5) Click Next. 
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6) A tree view of the schema represented the UML model is displayed.  This may take 

several minutes, depending on the size of your XMI file. 

 

7) Select a Feature Data Layer and then Click Properties. 

8) In the Feature Class dialog box, click the spatial reference button . 
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9) Under the Coordinate System tab of the Spatial Reference Properties Dialog Box, click 

Import and navigate to the corresponding coverage data in UTM Zone 10 NAD83 

Projection. 

 
10) Click the X/Y Domain Tab. Enter the following values. 

MinX: 512695  MaxX: 536068 

MinY: 5449361  MaxY: 5472734 

The above values are the coordinate values that are determined by arbitrarily drawing a 

rectangle box around the cadastre feature data layer.  This rectangle box serves as the 

buffer spatial extent around the District of Pitt Meadows. 
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11) Click Apply and Click OK. 

12) Repeat Steps 7 to 11 for all other feature data layers. 

13) Select an Attribute Table and click Properties. 

14) In the Attribute Table object class dialog box, click the Exists Tab. 

15) Match any unmatched attribute columns in existing class (meaning existing attribute table 

columns loaded in the geodatabase from Step 3) to the defined attribute columns in UML 

class model as shown below.  The unmatched ones are shown as “click to select…”. The 

reasons why these attribute columns are not matching are because the attribute names 

were changed in the UML model either because they are SQL reserved words or because 

they are formatted to be compliant to ICI cadastre attribute columns (SEE APPENDIX 3 for 

details). NOTE: Make sure there is a check beside the Feature class already exists in 

database. 

 
16) Click OK when finished matching. 
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17) Repeat Steps 13 to 16 for all other attribute tables.   

18) In the Schema Wizard dialog box as shown in Step 6, click Next. 

19) Click Finish in the new Schema Wizard dialog box. 

 

 

20) Click Yes to see log file. 

 

 

21) The geodatabase should appear similarly as follows in the ArcCatalog; 
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STEP 6: Load Feature Layers to Geodatabase in ArcMap 
 

Instead of using the Simple data loader in ArcCatalog, the Data Loader in ArcMap is used to load 
data because Simple Data Loader only loads data without behaviour or relationship classes.  
 

1) In ArcMap, Click Tools and click Customize. 

2) Click the commands tab in the Customize dialog box. 

3) Click Data Converters. 

4) Drag the Load Objects command from the Commands list and drop it such that the Load 

Objects button  appears on the Standard toolbar. 

5) Click Close on the Customize dialog box. 

6) Click on the Add data button . 

7) Navigate to the personal geodatabase and select all the feature data layers.  You can 

select multiple layers by holding down the SHIFT KEY button of the keyboard. 

8) If Editor toolbar is not shown in ArcMap, go to View and Click Toolbars and Click Editor. 
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9) Click the Editor button on the Editor Toolbar and Click Start Editing. 

 

10) Click the Target button and select the Feature Data Layer that you want to Load Data. 

 

11) Click the Load Objects button . 

12) In the Object loader dialog box, click the directory button  and navigate to the 

corresponding feature coverage. 
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13) Click Add and Click Next. 

 
14) Match the unmatched attribute columns in the object loader dialog box.  Again, these 

attribute columns are not matching as the attribute names were changed in the UML model 

either because they are SQL reserved words or they are formatted to be compliant to ICI 

cadastre attribute columns (See APPENDIX 3 for details). 
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15) Select Load all of the source data and Click Next. 

 
16) Click No to snap “Your features are precisely located” and Click Yes to “validate the new 

features and create a selection of all invalid features”.  Then Click Next. 

Note: The snapping environment defines the spatial extent of the loading data.  If the 

snapping is defined by its precise location, then the spatial extent will equal the original 

data’s spatial extent.  If the snapping is defined by current snapping environment, the 

spatial extent will equal the spatial extent of the geodatabase (defined in Step 10 of Create 

Geodatabase Schema using CASE Tools and XMI file). 

 



USER’S DOCUMENTATION  P.25 
Pitt Meadows Geodatabase V1.0 Basic Technical Manual                                                    
 

17) Click Finish. 

 
18) ArcMap will start loading the coverage’s data into the feature class of the geodatabase.  

You can see the loading status on bottom left corner. 

 
19) Click Editor and Save Edits. 

20) Repeat Steps 10 to 20 for all other feature data layers. 

21) Click Editor and Stop Editing and Save all Changes when finish loading all data. 
 
 

STEP 7: Check Relationships in ArcMap 
 
1) In ArcMap, turn on the cadastre feature layer. 

2) Click the identify button  and click on any parcel. 

3) In the Identify dialog box, minus the + on the left as shown below.  You should see all the 

data layers in your geodatabase.  Those layers without + button means that there is no 

attribute information on the identified parcels. 



USER’S DOCUMENTATION  P.26 
Pitt Meadows Geodatabase V1.0 Basic Technical Manual                                                    
 

 
4) Repeat Steps 1 to 3 to check the relationships and related data in the geodatabase 

 

 
STEP 8: Copy Personal Geodatabase to ArcSDE in ArcCatalog  

 
1) In ArcCatalog Tree, click on the personal geodatabase.  Select all the layers (feature 

class, object/attribute class and relationship class) under Content Tab on the right.  You 

can select all layers by holding down the SHIFT KEY. 

2) Right click and click copy. 
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3) In ArcCatalog Tree, click Database Connections and select the ArcSDE database and 

Connect.  If the ArcSDE database is not mapped yet, mapped it. 

 
4) Under the Content Tab of the ArcSDE database, right click and click paste.  
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5) In the Data Transfer Dialog Box, Click OK. 

 
6) A Data Transfer Progress Dialog box pops us to show the transferring process.  This will 

paste all the data layers in your personal geodatabase to the ArcSDE geodatabase. 
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UNRESOLVED ISSUES & RECOMMENDATIONS  

1) Many-to-many relationships: 

Some feature layers and attribute tables were not included in the current project because 

they require populating values into an intermediary many-to-many relationship class table.  

These data values are necessary for linking the data layers (such as soils, capability, and 

OCP_Urban) to the cadastre.  However the procedure for populating these values can only 

be accomplished either manually (adding row-by-row) or through an automated ArcObjects 

script.  Such ArcObjects script is available in support ERSI online but apparently it 

populates values into a new relationship class table rather than populating existing 

relationship class table established through CASE Tools.  As time constraints and lack of 

resources, it is impossible for the SFU students to explore further.  For information about 

the mentioned methods (manual adding or automated script), see “Create a many to many 

relationship in a geodatabase” at support esri online at  

http://support.esri.com/Search/KbDocument.asp?dbid=21708. 

 

Note: For data layers like soils and capability, they can be linked to cadastral feature layer by 

an overlaying procedure.  This procedure uses the ARC/INFO INTERSECT command to 

create a new coverage with attribute values from both cadastre and soils/capability.  The 

values in this table can then be uploaded to the many-to-many relationship class table for 

linking the layers.  Note that the procedure requires using cadastre’s UNIQUE ID for linking.  

For ocp_urban, it should be possibly link to cadastre by populating the many-to-many 

relationship class table with ocp definition and zoning codes.  

 

2) Cadastre’s UNIQUE ID 

Further revision is required in developing the cadastre’s UNIQUE ID.  In the current 

geodatabase, attempts were made on creating this UNIQUE ID by joining the JUROL and 

PID.  Since there are missing JUROL and PID numbers in the cadastre, this attempt was 

not too successful. 

 

3) Missing data:  

Many data layers were not loaded into this geodatabase due to lack of attributes.  The 

following describes the problems of these layers in detail: 

• 

• 

Water Utility, Storm, and Sanitary sewer require geocoding.  The District's 

engineering department has attributes for water utility, but we understand the only way 

to add these attributes into the GIS file is to do it manually.   

OCP_Rural could be updated so it contained all parcels in the rural area.  

Furthermore, its boundaries should be defined by parcels. 

http://support.esri.com/Search/KbDocument.asp?dbid=21708
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• The Roads layer could be linked to the Cadastral layer after missing addresses or 

house numbers are added, and the street names between the two layers has been 

standardized.  After the above problems have been corrected, the Roads and 

Cadastral layers, can easily create an intermediate table to link these two layers, using 

the ARC/INFO ADDRESSMATCH command. 

 

4) ICI compliant 

In the future, newly collected attribute data for utility feature class layers (Storm, Sanitary 

and Water Utility) should be ICI compliant (with GPS). 

 

5) ROLL numbers 

Many roll numbers are missing in the rural areas of District of Pitt Meadows in the cadastre.  

This should be examined in the future to affirm if this is correct.  Furthermore, new revised 

data layers like water services or pitt meadows septic system will require formatting the roll 

numbers before loading back to the geodatabase.  

 

6) Linkage to other Database 

Linking property information (obtained from AgFocus files) from current geodatabase to 

Vadim Finance Database should be explored in the future because it is beneficial to the 

business function of the District.   

 

7) Metadata 

More metadata should be collected wherever possible in the future.  

 

8) Timestamp or Date Stamping Capability 

Data model should be updated to include all existing cadastre versions with "date stamping" 

capabilities.  This permits urban development analysis by looking at the changes in the 

parcels. 

 

9) Identify Display User Interface 

An identify display user interface should be created in ArcMap such that the related data can 

be displayed more efficiently and nicely when clicking on a parcel using the identify tool.  

Note: The ArcMap’s defaulted identify display dialog box is shown in Step 3: Check 

Relationships in ArcMap. 
 
10) Inheritance in the Data Model 

Inheritance between Data Model classes should be set up in the Visio model such that 

attributes including JUROL are inherited so that changes in the Cadastral class are inherited 
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to all other classes containing that attribute.  Due to time constraints this was not 

accomplished by the SFU students. 

 

11) Tagged Values Available to be Added 
Class Domain may be set to allow only a specific range of values to be entered and 

Relationship Rules may also be created to control which classes may be linked to other 

classes.  This was not accomplished by the SFU students due to time constraints. 
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CONCLUSION 

Phases beyond the current model should consider integrating more feature classes.  The 

District of Pitt Meadows’ GIS department is encouraged to continue with its forward thinking GIS 

initiatives, and encouraged to partner again with SFU students in order to implement the various 

suggested future upgrades in a timely manner. In order to enable easy integration into the 

Geodatabase model, it is suggested that the District develop standards for data collection and 

AutoCad related files, and wherever possible to comply with ICI standards.  
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APPENDIX 1: CADASTRE_LOT.AML 

 
/*CAD_ANNOLOT.AML 
/* 
/* Purpose: This AML creates an anno. coverage with LOT as subclass. 
/*     It labels the Pitt meadows cadastre data parcels with  
/*          LOT descriptions in the new anno coverage. 
/*    
/* ---------------------------------------------------------------- 
/* Usage: &run cadastre_annolot 
/* 
/* 
/* Assumptions: assume cadastre data is in the same directory 
/*              assume only cadastre coverage, cadanno_plan.aml and  
/*              cadanno_lot.aml in the current directory (meaning no other files) 
/*              assume cadanno_plan.aml is in the same directory  
/*  
/* Note: - Calls the CAD_ANNOPLAN.AML to add PLAN 
/*    annotation to CAD_ANNO coverage. 
/* 
/* Output: coverage called cad_anno in current folder 
/*      
/* ---------------------------------------------------------------- 
/* History: LRC (Land Reserve Commission) - 10-AUG-2001  
/*                            Created by Darrin Grund, Betty Ling 
/*                            for creating cadastre lot annotation 
/*                            of Capital Regional District 
/* Modified: March-2003 Modified by Carol Cheuk for creating Pitt 
/*                      Meadows Cadastre lot annotation 
/* 
/* ================================================================ 
 
&IF [EXISTS  cad_anno -COVER] &then 
 KILL  cad_anno all 
 
/*set cadastre coverage name to .cover variable 
&sv .cover = [listfile * -cover] 
 
&IF [NULL %.cover%] &then &do 
&type Missing coverage 
&call usage 
&return 
&end 
 
copy %.cover% cad_anno 
centroidlabels cad_anno INSIDE 
build cad_anno 
 
/* ARCPLOT 
arcplot 
 
display 9999 
mape cad_anno 
 
polygonlines cad_anno 1 
 
annocoverage cad_anno LOT 
 
/*Create annotation for different area sizes 
annolevel 1 
reselect cad_anno poly AREA < 800 
textset font 
textsize 0.1 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 2 
clearselect 
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reselect cad_anno poly AREA >= 800 and AREA < 1600 
textset font 
textsize 0.15 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 3 
clearselect 
reselect cad_anno poly AREA >= 1600 and AREA < 2400 and LOT NOT cn 'REM' 
textset font 
textsize 0.25 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 4 
clearselect 
reselect cad_anno poly AREA >= 2400 and AREA < 3200 and LOT NOT cn 'REM' 
textset font 
textsize 0.3 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 5 
clearselect 
reselect cad_anno poly AREA >= 3200 and AREA < 6400 and LOT NOT cn 'REM' 
textset font 
textsize 0.35 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 6 
clearselect 
reselect cad_anno poly AREA >= 6400 and AREA < 12800 and LOT NOT cn 'REM'  
textset font 
textsize 0.45 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 7 
clearselect 
reselect cad_anno poly AREA >= 12800 and AREA < 36000 and LOT NOT cn 'REM'  
textset font 
textsize 0.7 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
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annolevel 8 
clearselect 
reselect cad_anno poly AREA >= 36000 and AREA < 72000 and LOT NOT cn 'REM' 
textset font 
textsize 0.8 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 9 
clearselect 
reselect cad_anno poly AREA >= 1600 and AREA < 3200 and LOT CN 'REM' 
textset font 
textsize 0.15 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 10 
clearselect 
reselect cad_anno poly AREA >= 3200 and AREA < 12800 and LOT CN 'REM' 
textset font 
textsize 0.25 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 11 
clearselect 
reselect cad_anno poly AREA >= 12800 and AREA < 72000 and LOT CN 'REM'  
textset font 
textsize 0.45 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 12 
clearselect 
reselect cad_anno poly AREA >= 72000 and AREA < 144000 
textset font 
textsize 0.9 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 13 
clearselect 
reselect cad_anno poly AREA >= 144000 and AREA < 700000 
textset font 
textsize 1 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
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textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 14 
clearselect 
reselect cad_anno poly AREA >= 700000 and AREA < 2000000 
textset font 
textsize 2.5 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
annolevel 15 
clearselect 
reselect cad_anno poly AREA >= 2000000 
textset font 
textsize 3.5 pt 
textcolor 'black' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno LOT # lc 
 
clearselect 
/* Quit out of ARCPLOT 
q 
 
/* ARC prompt 
/* Create attribute table (.TAT) for the annotation subclass 
 
build cad_anno anno.lot 
addtext cad_anno lot 
 
/* Calls ANNO_PLAN.AML to add PLAN descriptions on parcel(s) 
&r cad_annoplan cad_anno 
 
/* END OF CAD_ANNOLOT.AML  
/* ================================================================ 
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APPENDIX 2: CADASTRE_PLAN.AML 
 
/*CAD_ANNOPLAN.AML 
/* 
/* Purpose: This AML adds PLAN annotation as new subclass to the cad_anno 
/*          coverage.  It labels the Pitt meadows cadastre data parcels with  
/*          PLAN descriptions in the existing cad_anno coverage. 
/*    
/* ---------------------------------------------------------------- 
/* Usage: automatically run after cad_annolot.aml 
/* 
/* Arguments: <none> 
/* 
/* Assumptions: assume cad_anno data is in the same directory 
/*  
/* Output: Plan annotation subclass in cad_anno coverage in current folder 
/*      
/* ---------------------------------------------------------------- 
/* History: LRC - 10-AUG-2001 Created by Darrin Grund, Betty Ling 
/*                            for creating cadastre PLAN annotation 
/*                            of Capital Regional District 
/* Modified: March-2003 Modified by Carol Cheuk for creating Pitt 
/*                      Meadows Cadastre PLAN annotation 
/* 
/* ================================================================ 
&goto skip 
&args .cover 
 
&IF [NULL %.cover%] &then &do 
&type Missing coverage 
&call usage 
&return 
&end 
 
&label skip 
 
&IF [EXISTS cad_anno2 -COVER] &then 
 KILL cad_anno2 all 
  
/* Dissolve the parcels 
dissolve cadastre cad_anno2 PLANDEFDOC poly 
build cad_anno2 
centroidlabels cad_anno2 OUTSIDE /*INSIDE 
 
/* ARCPLOT 
ap 
display 9999 
 
mape cad_anno2 
polygonlines cad_anno2 1 
 
/* Add anno coverage to cad_anno2 
annocoverage cad_anno PLANDEFDOC 
 
annolevel 1 
reselect cad_anno2 poly AREA < 1000 
textset font 
textsize 0.075 pt 
textcolor 'gray'   
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno2 PLANDEFDOC # uc 
 
annolevel 2 
clearselect 
reselect cad_anno2 poly AREA >= 1000 and AREA < 10000 
textset font 
textsize 0.15 pt 
textcolor 'gray' 
textfont 93726 
textstyle simple 
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textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno2 PLANDEFDOC # uc 
 
annolevel 3 
clearselect 
reselect cad_anno2 poly AREA >= 10000 and AREA < 50000 
textset font 
textsize 0.5 pt 
textcolor 'gray' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno2 PLANDEFDOC # uc 
 
annolevel 4 
clearselect 
reselect cad_anno2 poly AREA >= 50000 and AREA < 100000 
textset font 
textsize 0.75 pt 
textcolor 'gray' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno2 PLANDEFDOC # uc 
 
 
annolevel 5 
clearselect 
reselect cad_anno2 poly AREA >= 100000 and AREA < 1000000 
textset font 
textsize 1.5 pt 
textcolor 'gray' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno2 PLANDEFDOC # uc 
 
annolevel 6 
clearselect 
reselect cad_anno2 poly AREA >= 1000000 
textset font 
textsize 2 pt 
textcolor 'gray' 
textfont 93726 
textstyle simple 
textquality proportional 
textalignment center 
textjustification cc 
labeltext cad_anno2 PLANDEFDOC # uc 
 
 
/* Quit out of ARCPLOT 
q 
 
/* ARC prompt 
/* Create attribute table (.TAT) for the annotation subclass 
 
build cad_anno2 anno.PLANDEFDOC 
addtext cad_anno PLANDEFDOC 
 
/* CLEAN-UP The temp coverage 
KILL cad_anno2 all 
 
&return 
 
/* END OF CAD_ANNOPLAN.AML  
/* =============================================================== 



USER’S DOCUMENTATION  P.40 
Pitt Meadows Geodatabase V1.0 Basic Technical Manual                                                    
 
APPENDIX 3: Changes Made to Original Table/Column/Length  
 

OLD NEW LOCATION DESCRIPTION REASON 

GISINTF PROPERTYINFO N/A Table Name Better describes the 

purpose of the table 

CADASTRE CADASTRAL N/A Table Name ICI Compliance 

PCL PARCEL Cadastral Attribute 

Column Name 

ICI Compliance 

BLK BLOCK Cadastral Attribute 

Column Name 

ICI Compliance 

CROWNADMIN CROWN_ADMIN Cadastral Attribute 

Column Name 

ICI Compliance 

PRIMARY PRIMARY_FIELD Cadastral Attribute 

Column Name 

SQL Reserved 

Keyword 

STREETNAME ST_NAME Cadastral Attribute 

Column Name 

ICI Compliance 

STREETTYPE STREET_TY Cadastral Attribute 

Column Name 

ICI Compliance 

PLACENAME PLACE_NAME Cadastral Attribute 

Column Name 

ICI Compliance 

DATAOWNER DATA_OWNER Cadastral Attribute 

Column Name 

ICI Compliance 

COMMENTS LENGTH = 255 Cadastral Attribute 

Column Length 

Necessary for loading 

into ArcSDE 

DESCRIPT LENGTH = 255 Cadastral Attribute 

Column Length 

Necessary for loading 

into ArcSDE 

PERCENT DESIGNPERCENT PittMeadows 

Designation 

Attribute 

Column Name 

SQL Reserved 

Keyword 

COUNT COVERCOUNT LandCover Attribute 

Column Name 

SQL Reserved 

Keyword 

SIZE COVERSIZE LandCover Attribute 

Column Name 

SQL Reserved 

Keyword 

PAGECOUNT PRECISION = 12, 

SCALE = 4 

WaterServices Attribute 

Column 

Precision & 

Scale 

Cannot enter 0 as 

Scale for a Double data 

type 
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DATE_INST PRECISION = 17, 

SCALE = 9 

WaterServices Attribute 

Column 

Precision & 

Scale 

Cannot enter 0 as 

Scale for a Double data 

type  

FARMUSE DATA TYPE = 

SMALLINTEGER, 

PRECISION = 1 

PittMeadows 

Designation 

Attribute 

Column Data 

Type and 

Precision 

Cannot have a 

Character string with 

the length of 1 

IN_ALR 

 

& 

 

ALREDGE 

 

& 

 

PARTALR 

DATA TYPE = 

SMALLINTEGER, 

PRECISION = 0 

PittMeadows 

ALR 

Attribute 

Column Data 

Type and 

Precision 

Cannot have a 

Character string with 

the length of 1; since 

the column is empty it 

cannot be loaded with 

the data table in 

ArcCatalog without 

specifying an empty 

column precision 

FARMUSE DATA TYPE = 

SMALLINTEGER, 

PRECISION = 0 

PMSpecies Attribute 

Column Data 

Type and 

Precision 

Cannot have a 

Character string with 

the length of 1; since 

the column is empty it 

cannot be loaded with 

the data table in 

ArcCatalog without 

specifying an empty 

column precision 

 

***Width is used to determine the length and precision of integer, string, and data fields.  For 

double fields, the display width and number of decimal places are entered as Precision and 

Scale, respectively.  Any differences from these rules are documented above. 

***Attribute columns with Numeric data type are entered as double because Numeric is not 

included in the esriFieldTypes 

***Attribute columns with a specified number of decimal places in ArcInfo are entered with the 

data type Double, the Precision equal to the display width, and the Scale as the display width 

minus the column width.  
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